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Introduction
The audience response system from TurningPoint utilizes clickers and the TurningPoint software 
to administer interactive polling. Polling can be used to conduct surveys, tests, or assessments. An 
Instructor Kit is required to get started with TurningPoint Clickers.  Contact iTech for information on 
obtaining an Instructor Kit.

Each Instructor Kit contains the 
following contents:

• Quick Start Guide: general setup 
and operational instructions.

• Presenter Card: controls the 
polling program.

• Response Card: used by the 
audience to record responses.

• Receiver (USB): runs the 
TurningPoint App software and is 
necessary to conduct polls.

ResponseWare
Instead of using a ResponseCard to interact with the poll, participants can use ResponseWare. 
ResponseWare turns mobile devices into a virtual clicker. Participants can respond to questions 
with any web-enabled device including smartphones, tablets, laptops, or desktops. ResponseWare 
is available for download on the App Store and the Google Play Store for smartphones. 
Participants can also interact with the poll via a web browser. 

Both ResponseCards and ResponseWare require a subscription. ResponseCards come with a 
subscriptions upon purchase. To purchase a subscription for ResponseWare, direct participants to 
https://store.turningtechnologies.com.

https://store.turningtechnologies.com


Need support? Contact itech@plu.edu 
or visit us online at www.plu.edu/itech

Clickers Page 4

Getting Started
Create a TurningPoint Account

A TurningPoint account is necessary to use the TurningPoint App software.

To create a TurningPoint account:
1. Open a browser and navigate to https://account.turningtechnologies.com/.
2. Enter your PLU ePass credentials and click Create Account.
3. Fill out all required information in the new webpage to continue registration. When prompted, 

enter the Device ID from the Presenter Card, located below the barcode on the back of the 
device.

4. Click Finish when done.

Download & Install TurningPoint
TurningPoint App is the polling software. It can be launched and used from the Receiver itself 
(Not recommended), as well as directly from the computer (Recommended). All polls created and 
changed will be saved to your TurningPoint account. 

1. Open a browser and navigate to https://account.turningtechnologies.com. Login with your 
TurningPoint/PLU ePass credentials.

2. Click the Downloads tab to the top of the page.
3. Locate the TurningPoint options, and click the install link that matches your computer’s 

operating system (“PC Install” or “Mac”). The download will begin.
4. Click the install file after downloading is complete to begin installation. By default, the install 

Participant Lists

Content/Question 
Lists

Polling Modes

Tabs

https://account.turningtechnologies.com/
https://account.turningtechnologies.com
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file is saved in the Downloads folder.
a. Mac: click the .dmg file, then click-and-drag the TurningPoint icon to the Applications 

folder.
b. PC: click the .exe file and click through the installation process.

5. Open TurningPoint by clicking the icon in the Start Menu (PC) or Applications window (Mac).

 

Dashboard Interface
Tabs: the Dashboard is divided into three tabs: Polling, Content, and Manage. Polling modes are 
accessed and launched from the Polling Tab, Question Lists are created in the Content Tab, and 
polling results are reviewed in the Manage Tab.

Participant Lists: Participant Lists can be used to link student participant profiles from Sakai with 
responses (see the Participant List section). An “Auto” Participant List is created by default and can 
be used in place of a custom Sakai-imported one. 

Content/Question Lists: Question Lists created in TurningPoint App will show up in this panel 
under the Polling tab (see the Question Lists section).

Polling Modes: Polling Modes include PowerPoint Polling, Anywhere Polling, and Self-Paced 
Polling. Anywhere Polling is the recommended option. Click a Polling Mode to begin a polling 
session.

Pair the PresenterCard
The PresenterCard remotely controls polls. Use the PresenterCard to start and stop polls, as well 
as to navigate questions. The PresenterCard must be paired with the Receiver before it can be 
used.

To pair the PresenterCard and Receiver:
1. Navigate to the Polling Tab.
2. Above the polling modes, click the number below “Receiver” to open 

Connection Preferences. The number, which indicates the Receiver channel, is 41 by default.
3. Click Change next to “PresenterCard Device ID,” located below “PresenterCard.” A new pop-

up will appear.

4. Press any button on the PresenterCard. A string of numbers/letters will appear next to 
Detected Device ID.
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5. Click Save when done to finish pairing.

If the PresenterCard fails to pair, ensure its set to the same channel as the Receiver. See the next 
section for more details.

Changing the Channel
The Receiver, PresenterCard, and ResponseCard use channels to communicate with each other. 
Each must be set to the same channel for this communication to work, otherwise they will not be 
able to interact. 

The default channel is 41 for all devices. Be aware that if there are other groups using clickers in 
a close proximity, cross-talk may occur. If your polling behaves erratically and collects unknown 
responses, change your channels across all devices.

To check/change the Receiver channel, click the number below Receiver from the 
TurningPoint App Dashboard. In the new Connection Preferences window, the 
Receiver channel is accessed in a drop-down next to “Receiver” below “ResponseCard Channels.”

To check the PresenterCard and ResponseCard channels, press the Channel button 
on the card. The channel will be displayed to the top of the LCD screen. To change the 
channel on a card, type in a number and press the Channel button again.

Connect ResponseWare
If a participant desires to use ReponseWare instead of a ResponseCard, their device will need to 
be connected through a ResponseWare session in order for their responses to be recorded. See 
the ResponseWare section for more details on ResponseWare.

To connect ResponseWare:
1. Navigate to the Polling Tab.
2. Click “Click to Connect” below “ResponseWare.” The ResponseWare 

window will appear.
3. Click Start Session. A Session ID, along with other information, will be displayed.
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4. Instruct the participant(s) to either open the ResponseWare app on their smartphone device, 
or navigate to https://www.responseware.com from a web browser.

5. Instruct the participant(s) to enter the ResponseWare session ID when prompted and click 
Join Session.

6. Participants will need to login with their TurningPoint account and enter a user ID. As 
participants connect, the number next to Connections will update.

7. Click Close when all participants have successfully connected. Closing the ResponseWare 
window will not disconnect participants.

To end the ResponseWare session, click the session ID below 
“ResponseWare” on the Dashboard to re-open the ResponseWare window 
and click End Session. End ResponseWare sessions when polling is 
concluded.

Polling Connection Test
Before a polling session begins, test the connection of the participants’ ResponseCards to ensure 
all responses will be captured.

To test polling connections:
1. Navigate to the Polling Tab.
2. Above the polling modes, click the number below “Receiver.” The Connection Preferences 

window will appear. 
3. Under “Response Devices,” click the Test button next to “Polling Connections.” The Polling 

Test window will appear.

4. Instruct each participant to press any button on their ResponseCard. Responses from 
properly connected ResponseCards will be recorded in the window.

5. Ensure that all participants’ responses were registered.
6. Click Close when done.

If a response from a participant wasn’t registered during the test, ensure that they have their 
ResponseCard is set to the proper channel. See the previous section for more details.

Sakai Integration
Add TurningPoint tools to a Sakai course to upload students’ poll responses. This integration is 
helpful for keeping a record of students’ progress and can also be used for grading purposes.

https://www.responseware.com
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To enable TurningPoint tools on a Sakai site:
1. Navigate to the desired Sakai site.
2. Click Site Info from the Menu to the left.
3. Click the Edit Tools button from the top.
4. At the bottom of the page, click the “Add Clicker Tools” link. The page will be redirected to a 

webform.

5. When the Clicker Tools have been added to the site, they will appear in the Menu. Utilize the 
tools to connect your TurningPoint account.

6. After the TurningPoint tools are fully set up, instruct students to register their ResponseCard/
ResponseWare with the Turning Account tool.

Students’ Turning Account information can be imported into TurningPoint App as a Participant List 
to keep track of responses (see the Participant Lists section for more details).
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Polling Setup
Question Lists

Question Lists can be used during polling to show the participants the material they’re responding 
to. It is recommended to use Question Lists if another visual representation of the questions, such 
as a PowerPoint, will not be used, but they are not required to conduct a poll.

To create a Question list:
1. Navigate to the Content Tab.
2. Click the Content drop-down, located to the left of the interface, and select New -> Question 

List. A new pop-up will appear.

3. Give the Question List a name, and fill out the information as desired. 
• Preferences: determine details such as the number of questions and answers, the 

question type, font, size, etc. These settings can be changed individual questions later.
• Polling 

 ◦ Show Results: display the responses after each question.
 ◦ Correct Answer Indicators: indicates the correct answer for each question.
 ◦ Use Countdown Timers: set a time limit for each question.
 ◦ Show Response Grid: display a grid for each question of recorded devices that have 
responded.

4. Click Save when done. The window will be redirected to display the questions, which are 
currently empty. Use the Question drop-down to the top-left to add, duplicate, delete, and 
import questions.

5. Click the pencil icon to edit each question.



Need support? Contact itech@plu.edu 
or visit us online at www.plu.edu/itech

Clickers Page 10

• Question text: type the desired question text in the first text box. Text formatting options, 
such as font, size, and color, and available to the top of the text box.

• Answers: click the field next to each answer choice to edit the text. Text editing options 
for answers are the same as the options for questions. To add an additional answer, click 
“Add new answer here...”. To delete an answer, hover the cursor over the answer and click 
the red X that appears.

• Preferences: change the preferences of an individual question, such as the bullet format, 
in the panel to the far right.

6. Click Close to exit the question editing window.
7. When done editing the Question List, click Save and Close.

The new Question List will appear in the Content panel of the Content tab. It can also be accessed 
from the panel to the left in the Polling Tab. Question Lists are saved as files in the Content folder 
of the Receiver.

To edit a Question List, double-click it from the panel to the left of the Content Tab.

Question Preferences
Question Preferences are access from the panel to the right in the Question List editing window.

Polling Options

• Show Results: display results in a chart after every question.
• First Response Only: only the first response by a participant 

will be recorded.
• Correct Answer Indicator: the correct answer will be 

indicated after every question.
• Countdown Timer: automatically display a countdown timer 

when polling has started. Set the default amount of time in the 
field next to “seconds.”

• Response Grid: automatically display a grid of participants that have responded. This will 
display their name/device ID only and not their response.

Scoring Options

• Correct Point Value: set a custom value for correct 
responses.

• Incorrect Point Value: set a custom value for incorrect 
responses.

• Speed Polling: point values will decrease relative to the 
length of time that polling is open.

• Show Advanced Scoring: use to apply different weights to 
answers.

• Scoring drop-downs: set the correct/incorrect answers. If 
Advanced Scoring in enabled, enter the weight of the scoring 
for each question in the field to the right.

Question Options

• Anonymous: participants’ information will not be recorded with their responses.
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• Bullet format: the style of bullets for answers.
• Multiple responses: when enabled, participants can respond 

multiple times and all responses will be recorded. When 
disabled, only the most recent response per question will be 
recorded. 

Participant Lists
Participant Lists attach a participant to their response in the Session Data (see the section below). 
By default, an “Auto” Participant List is available. The Auto Participant List will only record results 
attached to participants ResponseCard ID/ResponseWare ID; it will not include the participant’s 
actual name or information. 

Participant Lists can be imported from Sakai courses that have TurningPoint tools (see the Sakai 
Integration section). Imported Sakai Participant Lists include the device ID, subscription status, 
first name, last name, user ID, and email of each student. Students will need to register their 
ResponseCard/ResponseWare to their profile in Sakai prior to importing a Participant List.

To import a Participant List from Sakai:
1. Navigate to the Manage Tab of the TurningPoint Dashboard.
2. Click the Participant List drop-down and select “New.” A pop-up will appear.
3. Select “Download from Integration” and click Create List. A new pop-up will appear.
4. Fill out the information as shown below.

5. Click Connect when done. A new pop-up will appear.
6. Select the desired course to import the students as a Participant List.
7. Click Import. 

The course’s Participant List will appear in the panel to the left in the Manage Tab. Select the 
Participant List to view the participant information in the window to the right. The Participant List 
will also be added to the left panel in the Polling Tab.
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Updating Participant Lists from Sakai
To update a Participant List from Sakai:

1. Navigate to the Manage Tab.
2. Select the Participant List from the panel to the left. The participant 

information will display in the window to the right.
3. Click the Results Manager button to the bottom-right. The window will 

be redirected. 
4. Click the Integrations button from the top. A pop-up will appear. 
5. Re-enter the information as shown in Step 4 of the previous instructions.
6. Click Connect. The pop-up will be redirected.
7. Select “Update Participant List” and click Update List.
8. Click Close to exit.

If any participants do not have a TurningPoint subscription, an error message will appear. Remind 
students to register their TurningPoint account to their Sakai profiles.

Deleting a Participant List
Delete outdated or irrelevant Sakai Participant Lists, if desired. The default Auto Participant List 
cannot be deleted.

To delete a Participant List:
1. Navigate to the Manage Tab.
2. Select the Participant List to the left.
3. Click the Participant List drop-down and select “Delete.” A pop up will appear.
4. Click Delete. If the Participant List contains Session Data, a pop-up with the following 

deletion options will appear
• Move Sessions to Auto
• Remove Sessions from TurningPoint
• Delete Sessions

Session Data
Every time a poll is initiated, a new Session is started. Polling results are recorded and saved for 
each session as Session Data. Session Data keeps track of recorded responses, corresponding 
participant information, and results during a poll. Session Data can be saved as a file on the 
Receiver for review in the Manage Tab (see the Review Results & Session Data section). Session 
Data can also be uploaded to Sakai, such as for grading purposes (see the Export Session Data 
to Sakai section).

When polling is conducted and Session Data is saved, it will appear in a drop-down of the 
corresponding Participant List in the Manage Tab.
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Anywhere Polling (recommended)
Anywhere Polling is the standard polling mode. It can be used to poll with 
Question Lists as well as to conduct polls on-the-fly. 

Anywhere Polling can also be used in combination with an external 
PowerPoint presentation. If a PowerPoint presentation is desired in place of a 
Question List, Anywhere Polling is recommended over TurningPoint’s built-in 
PowerPoint Polling mode as Anywhere polling is more stable and reliable.

When Anywhere Polling is launched, the Polling Window will appear.

Polling Window

Exit Polling: close a polling session and return to the Dashboard.

Start/Stop: start/stop a polling session.

Generic Question Options: if a pre-made Question List isn’t desired, set up a generic questions 
here. Questions will be displayed with generic text, such as “Question 1,” and “Answer A.”

Settings: access Session options, Participant Lists, Question Lists, and Preferences.

Show/Hide Options: toggle the visibility of windows during polling. All of these windows will 
appear on top of any other programs opened, and can be moved around the screen. From left to 
right, the Show/Hide Options are:

• Chart: a chart of recorded responses.
• Presentation: a window of the questions and answers. Show 

the Presentation in polls that rely on Question Lists, so that the 
participants can see the question and answers.

• Response display: a list of the response and responsible 
participant. Do not show if anonymity is desired.

• Response Grid: a grid of participants that have responded without showing 
the response.

• Countdown Timer: set a countdown timer to limit response time, if desired. 

Exit Polling

Start/Stop

Generic Question Options

Settings

Show/Hide Options

Number of Recorded Responses
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Countdown Timer settings are adjustable in Preferences. Click the plus button to add five 
more seconds, and the minus button to subtract five seconds.

• Connection Info: show the current channel the Receiver is set to.

Anywhere Polling Preferences
To adjust polling preferences, such as chart colors and countdown timer options, click 
the Settings button from the Polling Window and select “Preferences.” Settings for each 
polling mode, as well as for Software and Connections, can be changed in Preferences. Select 
“Anywhere” from the left to display preferences specific to Anywhere Polling.

Notable preferences include:

• Accept First Responses Only: only the first response by a participant will be recorded.
• Countdown Timer: automatically display a countdown timer when polling has started. Set the 

default amount of time in the field next to “Countdown Seconds.”

Conduct a Poll
To conduct a poll with Anywhere Polling:

1. Select a Question List and Participant List from the panel to the left in the Polling Tab, if 
applicable. If a custom Participant List isn’t desired, select the Auto list.

2. Launch Anywhere Polling from the Polling Tab. The Polling Window will appear.
3. Adjust Preferences and other options as desired. If a pre-made Question List isn’t desired 

for the poll, click the Generic Questions Options drop-down next to the Play/Stop button to 
quickly add a blank question list.

4. Click the Play button, either from the Polling Window or the PresenterCard, to open polling.
5. When the participants have responded to the question, click the Stop button to close polling.
6. Click the Play button to open polling for the next question.
7. Repeat steps 4-6 until all questions are completed.
8. Click the X to the top-left of the Polling when done to exit polling. A new 

window will appear regarding Session Data. 
9. Click Save to store the Session Data, if desired, or Don’t Save to discard it. 

To add polling results to previously-saved Session data, click the Settings button, hover over 
Session, and select “Continue Prior Session” from the pop-up. Locate the previously-saved 
Session Data file from the new window. See the Session Data section for more details.

To load a different Question List, click the Settings button, hover over Question List, and select 
“Load Question List” from the pop-up. In the new window, navigate to the saved Question List.

To toggle the visibility of optional windows, such as the countdown timer 
or the results chart, use Show/Hide buttons to the bottom of the Polling 
Window.

To restart polling, open the Settings, hover over Session, and select “Reset Session.”
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To re-poll a question, click the drop-down below the Play/Stop button 
and select the desired question. Only questions from Question Lists 
can be re-polled; if using a generic question list, this will not be an option.

Anywhere Polling with a PowerPoint Presentation
PowerPoint presentations can be used to display questions/answers in place of a Question 
List, or to show relevant graphics and materials. If a PowerPoint presentation is desired, it is 
recommended to use Anywhere Polling in combination with the presentation as TurningPoint’s 
built-in PowerPoint Polling mode is prone to crashing. For more details on PowerPoint Polling, see 
its section.

Before launching Anywhere Polling, create the PowerPoint presentation. It is recommended to 
include one question and its answer choices per slide. Refer to the previous section for details 
about similar steps.

To poll with Anywhere Polling and a PowerPoint presentation:
1. Create a PowerPoint presentation. 
2. Create a Question List that corresponds to the questions/answers in the presentation. 

Although the PowerPoint presentation will be displayed in place of the Question List, create a 
Question List as a reference for recording responses if desired. 

3. Select the Question List and desired Participant List from the panel to the left in the Polling 
Tab. If a custom Participant hasn’t been made, select the Auto list. 

4. Launch Anywhere Polling from the Polling Tab. The Polling Window will appear.
5. Load the appropriate Question List and adjust other options as described in the previous 

section.
6. Start the PowerPoint Presentation. As the Polling Window will float on top of the presentation, 

its buttons will be completely accessible when the slideshow is presented. Arrange all 
optional windows as desired.

7. Conduct polling as described in the previous section. Start and stop polling for each question 
slide.

8. Exit polling when done and save session 
data, if desired.

Like the Polling Window, all optional windows, 
such as the Countdown Timer and results chart, 
can be floated on top of the presentation. When 
creating the presentation, leave empty space on 
the slide for optional windows to appear over. 
To toggle the visibility of optional windows, use 
Show/Hide buttons to the bottom of the Polling 
Window.
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PowerPoint Polling
PowerPoint Polling integrates TurningPoint App polling with PowerPoint 
presentations. Be aware that this polling mode is prone to crashes. An 
alternative for polling with presentations is Anywhere Polling (see the 
Anywhere Polling with a PowerPoint Presentation section). With PowerPoint 
Polling, the presentation is created and the polling is conducted through 
TurningPoint App. Be aware that PowerPoint Polling may look different 
between the Mac and PC versions.

Create the Presentation
Presentations to be used with PowerPoint Polling must be made in this mode; previously created 
presentations are not able to be converted to PowerPoint Polling. A presentation must be made 
with PowerPoint Polling before a poll can be conducted.

To create a PowerPoint Polling presentation:
1. Launch PowerPoint Polling from the Polling Tab. PowerPoint will launch, with the addition of 

the TurningPoint Panel (below) and Slide Preferences Panel.

2. Click the New button to the far left of the TurningPoint Panel to create a question slide. 
Available question types include Multiple Choice, 
Short Answer, Numeric Response, True/False, Essay, 
Demographic, Priority Ranking, Likert, and Ice Breaker.

3. Edit the slide text as desired. Use standard PowerPoint 
functions to change the text formatting, such as size, 
color, etc.

4. Repeat for each desired question.
5. Navigate to File -> Save when done to save the 

presentation.

The presentation must be re-opened from TurningPoint App’s 
PowerPoint Polling to make edits later. The PowerPoint file 
cannot be opened in standard PowerPoint. To edit the presentation, launch PowerPoint Polling, 
navigate to File -> Open, and locate the file.

Creating New Slides

Use the New drop-down from 
the TurningPoint Panel to 
create a question slide. For 
non-question slides, such as 
graphics, use the New Slide 
button under the Home tab of 
PowerPoint.
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To insert an object directly into a slide, such as a countdown timer, click the Objects drop-
down from the TurningPoint Panel. Alternatively, optional windows can be floated on top of the 
presentation (see the Conduct a Poll section below for more details).

To load a Question List made in TurningPoint App, click the Tools drop-down and select Import 
Question List.

Slide Preferences Panel
Use the Slide Preferences Panel to access question, polling, and scoring 
options. Preferences are set for individual slides and will not affect the rest 
of the presentation. Select the desired slide before adjusting preferences. 
The options available in the Slide Preferences Panel are the same as 
those available for Question Lists in TurningPoint App (see the Question 
Preferences section). 

Conduct a Poll
Before conducting a poll with PowerPoint Polling, create the presentation first through TurningPoint 
App as described in the previous section. All polling controls for PowerPoint Polling are located in 
the TurningPoint Panel. 

To conduct a poll with PowerPoint Polling:
1. Launch PowerPoint Polling from the Polling Tab.
2. Navigate to File -> Open to open a previously-created presentation, or follow the steps in the 

above section.
3. Set up options.

• Participant List: to use a custom Participant List, click the drop-down under “Participants” 
in the TurningPoint Panel and select it. To import a new Participant List from Sakai, click 
the Manage drop-down (see the Participant List section for more details). If a custom 
Participant hasn’t been made, select the Auto list.

• Session data: when polling is initiated, a new Session is started. To add to a previously 
saved session, click Continue under “Sessions” in the TurningPoint Panel. Locate the 
previously saved session file from the new window. Before polling begins, click the Reset 
button and select “Session” from the pop-up to start a recording new session data.

4. Click the Start button to open polling. The slideshow will begin and the Polling Showbar will 
appear. The Polling Showbard contains all the polling controls. Refer to the table at the end of 
this section as a reference for the Polling Showbar contents.

5. Click the Play button, either from the Polling Window or the PresenterCard, to open polling.
6. When the participants have responded, click the Stop button to close polling.
7. Advance to the next question slide.
8. Repeat steps 6-8 until all questions are completed.

9. Press the Escape key when done to exit the slideshow. 
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To save Session data, click the Save button from the TurningPoint Panel and select “Save as New 
Session.” For more details, see the Session Data section.

To toggle the visibility of optional windows during polling, such as the countdown timer or the 
results chart, click a desired Show/Hide button from the Polling Showbar.

To re-poll a question, click the Repoll button from the Polling Showbar.

To restart polling, exit the slideshow, click the Reset button from the TurningPoint Panel, and 
select “Session” from the pop-up.
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Minimize Showbar
Minimize the Polling Showbar to only display 
the Responses, Polling Status, and Maximize 
Showbar button.

Toggle Response Count Toggle between response counts or percentages 
on the results chart.

Repoll Question
Clears the responses from the current question. 
Both the original as well as repolled responses are 
saved in the session data.

Response Display Shows the participants and their responses while 
polling is open.

Response Grid
Toggle the Response Grid, which displays which 
participants have responded to the current 
question.

Countdown Timer
Toggle a countdown timer for the current question. 
Start/stop, as well as add/subtract time of the 
countdown.

Insert New Question
Quickly add a new question slide. Select a slide 
type from the drop-down to be inserted into the 
presentation.

Attendance (for polls using 
Sakai-generated Participant 
Lists only)

Open an attendance poll. Participants can 
press any button on their ResponseCard to be 
counted. The Present/Absent buttons toggle which 
participants are displayed. Click Close Polling to 
end the attendance.

Set Anonymous Participant information will not be recorded with 
the results.

Delete Last Question Polled

Deletes the response data from the current 
question. This does not reset the chart, and 
response data will not be saved in the session 
data.

Data Slice Allows the chart to display responses from 
previous slides.

Original Chart Display the results chart, in original form, in the 
slide.

Participant Monitor Displays current participants.

Connection Info Displays the Receiver channel number.

Messaging Window Opens the feedback monitor.

Responses Displays the number of responses for the current 
question.

Polling Status Displays the current polling status: Open or 
Closed.
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Self-Paced Polling (ResponseWare Only)
Self-Paced Polling allows participants to respond to assessments, evaluations, 
and surveys at their own speed using ResponseWare (see the ResponseWare 
section). In this polling mode, participants will respond to questions using their 
desired ResponseWare device such as a smartphone, tablet, or laptop. A 
Question List is required to use Self-Paced Polling.

To conduct a poll with Self-Paced Polling:
1. Create a Question List (see the Question Lists section).
2. Start a ResponseWare session (see the Connect ResponseWare section).
3. Select the Question List and desired Participant List from the panel to the left in the Polling 

Tab. If a custom Participant hasn’t been made, select the Auto list.
4.  Launch Self-Paced Polling from the Polling Tab. If a pop-up will appears regarding a 

question list and ResponseWare, click Cancel and ensure a ResponseWare session is active 
and a Question List is selected, and try to launch Self-Paced Polling again.

5. Click the Accept Logins button from the top-left. A pop-up will appear.

6. Set a time limit or completed test message in the pop-up. Set Participant Login to “Off.”
7. Click OK when done. The pop-up will close and the Self-Paced Polling Window will update. 

Connected participants will appear in the window.
8. Click the Start Polling button to the top-left to open polling. The participants’ ResponseWare 

will update and they will be able to access the poll.
9. Click the Stop Polling button from the top-left to close polling when done. The participants will 

no longer be able to interact with the poll.

To save the Session Data, click the Save button to the top-left after polling is closed (see the 
Sessions section for more details).

To check the progress of the participants at any time, click the Live Results button.



Need support? Contact itech@plu.edu 
or visit us online at www.plu.edu/itech

Clickers Page 21

Review Results & Session Data
Every time polling is closed, a window regarding session data saving will appear. Save session 
data to keep a record of responses, such as for grading purposes or future reference. Session 
data is saved as a file in the Sessions folder on the Receiver. Review session data later in the 
Manage tab of the Dashboard.

To review saved session data:
1. Navigate to the Manage Tab.
2. Click the Session drop-down and select Import from the pop-up. A new pop-up will appear.
3. Located the saved data file and click Open. The Session will appear in a drop-down below 

the corresponding Participant List in the panel to the left.
4. Double-click the Session from the list. The window will be redirected to a results overview. If 

a pop-up regarding unlicensed participants appears, click OK.

5. Click Close when done.

To export the results as a file, such as a CSV, Excel, or HTML, click the Export drop-down menu 
to the top-left.

To change how the results are displayed, such as by question or participant, click the drop-down 
to the top-right and select an option from the pop-up.

Export Session Data to Sakai
Session Data can be exported into a Sakai course that has TurningPoint tools set up (see the 
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Sakai Integration section). In order to track students’ responses properly, the poll also must be 
conducted with a Participant List imported from Sakai (see the Participant Lists section).

To export Session Data to Sakai: 
1. Navigate to the Manage Tab.
2. Select the desired Session in the drop-down of the course’s Participant List.
3. Click Results Manager to the bottom-right. The window will be redirected.

4. Click the Integrations button. Enter the following information in the pop-up that appears.
5. Click Connect. The pop-up will be redirected.
6. Click Export Sessions. Click to select which Session(s) to export to Sakai. Results for 

participants who do not have an active TurningPoint subscription will not be exported.
7. Click Export and click through until completed.
8. Access the Sakai course to verify that the Session Data imported correctly with the 

TurningPoint tools.


	Introduction
	ResponseWare

	Getting Started
	Create a TurningPoint Account
	Download & Install TurningPoint
	Dashboard Interface
	Pair the PresenterCard
	Changing the Channel
	Connect ResponseWare
	Polling Connection Test
	Sakai Integration

	Polling Setup
	Question Lists
	Participant Lists
	Session Data

	Anywhere Polling (recommended)
	Polling Window
	Conduct a Poll
	Anywhere Polling with a PowerPoint Presentation

	PowerPoint Polling
	Create the Presentation
	Conduct a Poll

	Self-Paced Polling (ResponseWare Only)
	Review Results & Session Data
	Export Session Data to Sakai


